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Overview 
 
Adobe Illustrator is a vector-based graphic design tool. It was primarily designed 
for creating materials for print publications but has since been modified to 
support content and web graphics creation. Illustrator is best known for its ability 
to create scalable graphics. Artists can work big and shrink their graphics down 
without loss of quality. 
 
Illustrator is not a photo-manipulation tool; it is a drawing tool. Therefore, if you 
are familiar with Photoshop, you may find Illustrator very confusing and hard to 
work with at first. 
 
The goal of this workshop is to teach you how to use most of the common tools 
and have you perform simple drill exercises with each tool we cover. We will 
discuss the following tools and topics: 
 

• The Hand and Magnification Tools by Keyboard 
• Shapes tools (Ellipse, Star, Polygon, Rectangle 
• Selection (Solid Arrow) and Direct Selection (Hollow Arrow) tools 
• Precise copies and Duplication 
• The Pen Tool 
• Type Tool 
• The Pathfinder 
• Transformation tools 
 

Let’s first start by doing an overview of the tool palette in Illustrator 9.0. You will 
find a diagram of the tools on Page 2, followed by a detailed description of the 
tools on page 3. 
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Tool Palette and Tear-offs Overview 
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Tool Palette and Tear-offs Description 

 
 

Selection Tool Used to move or resize an ENTIRE object, group of objects or group of paths
Direct Selection Tool Used to move or manipulate a point, curve, path, or group of paths
Lasso Tool Used to mark a selection area and has the same effects as the selection tool
Direct Lasso Tool Used to mark a freehand selection area and has the same effects as the direct selection tool

Pen Used to create lines and curves
Add Point Used to add a manipulation point to a line
Subtract Point Used to remove a manipulation point from a line
Convert Point to Curve Used to convert a manipulation point to a curve point

Type Tool Used to place text on your drawing
Area Type Used to fill a shape with text that will flow inside of the shape
Path Type Used to create text that follows a path
Vertical Type Used to display text vertically instead of horizontally
Vertical Area Type Used to fill a shape with text that will flow vertically inside of the shape
Vertical Path Type Used to display text vertically along a path.

Elipse Draws an elipse
Polygon Draws a polygon
Star Draws a star
Spiral Draws a spiral

Rectangle Draws a rectangle
Rounded Rectangle Draws a rectangle with rounded corners

Rotate Rotates the selected object
Twirl Twirls the selected object

Pensil Allows for freehand illustration (Use with a stylus for best results)
Smooth Creates smudged textures
Eraser Erases selections

Reflect Reflects a selection over an axis
Shear Skew or distort a selectiojn

Free Transform Transforms objects 

Scale Scale a selection to enlarge or decrease the size
Reshape Freehand transformation tool

Blend Creates blends from one shape to another in steps
Auto Trace Attempts to trace paths of a pattern

Chart tools Creates  charts and graphs

Gradient Mesh Creates a 3D gradient effect on a shape

Gradient Applies a gradient over an area or shape

Eyedropper Selects a color and applies it to the current FILL color
Paint Bucket Fills a shape with the color specified

Hand tool Used to move the focus of the screen
Screen tool Used to move the border of your page
Measure tool Used to measure elements on the screen

Magnifier Used to zoom in and out of your project
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Beginning Illustrator 
 
 When you first begin, there are some things you have to be aware of.  
Primarily, though the interface may resemble Photoshop in many ways, it is most 
definitely NOT the same. The tools and their associated functions work entirely 
different. 
 
Before we begin, we will need to make some settings adjustments. Click Edit, 
and choose Preferences. Please make sure your settings match the ones shown 
below. 
 

 
 
 
The first thing you will need to do to start the exercises is create a new 
document.  Do this by clicking the File menu, and choose New. You will be 
presented with the following dialogue. 
 

  
The settings for our 
examples will be 
using Points rather 
than pixels or 
inches. The settings 
here are equal to an 
8.5 x 11 inch page.
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The Hand and Magnification Tools 
 
 The Hand and Magnification tools make it easy to position your drawing in 
a way so that it is easy for you to work with. You can zoom in and then move 
your view around.  However, when you are working on your project, it can be 
cumbersome to switch from the Pen tool to the Hand tool, and back to the Pen 
tool again.  Likewise, when working on a small area of a project, it can be 
annoying to have to select the Magnifier tool to zoom in, and then moving to the 
View menu to zoom out. 
 Adobe addressed these issues by assigning hot keys that automatically 
change the mouse cursor when pressed. 
 
To access the Hand tool, press and hold the Space Bar. Your cursor will change 
to the Hand icon. While holding the Space Bar, you can drag the screen around, 
changing the center of focus. Releasing the keyboard keys returns you to your 
previous tool. 
 
To access the Magnifier tool, press and hold Space Bar + CTRL. Your cursor 
will change to the Plus Magnifier, allowing you to click the mouse and zoom in.  
Releasing the keyboard keys returns you to your previous tool. 
 

Pressing and holding Space Bar + CTRL + ALT will change your cursor 
to the Minus Magnifier, allowing you to zoom out. 

 
To move objects without selecting the Selection arrow, hold down the CTRL key 
and drag your object. This can be extremely useful when placing type. 
 
There is a slight inconsistency with the aforementioned shortcuts; the Hand tool 
and Magnification tool do not activate via shortcut when you are using the Type 
tools. 
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Shapes Tools, Stroke, and Fill 
 
Creating shapes in Illustrator is much like using the Marquee tool in Photoshop or 
the Box tool in Microsoft Paint. You start at one corner, click and drag to an 
opposite corner, then release.  The ellipse, rectangle, star, spiral, and polygon all 
work the same way. However, when used in conjunction with keyboard hotkeys, 
these tools have special features. 
 
Let’s do a regular rectangle.  Choose the Rectangle tool from 
the palette.  Click anywhere on the artboard and hold the 
button down.  Drag to an opposite corner and you will see 
your shape appear.  When you are satisfied with the size, 
release the mouse button.  You should have a shape similar to 
the one shown to the right. 
 

Notice your Fill and Stroke items on your palette. If they appear 
exactly like in the example to the left, then you should see a box with a 
white inside and a black outside. Note that these are not Foreground 
and Background colors like in Photoshop. To change the fill color of 
the square, simply double-click the Fill color and select a new color 
from the color picker.  Do the same to change the stroke color.   

If you do not want a stroke, simply click the Stroke once, and then click the None 
button (the box with the red slash). 
 
If, when you created your square, deselected your square, and saw nothing, then 
you probably did not have a stroke applied to your object.  To make sure you are 
seeing everything you actually draw, most artists recommend working in the 
Artwork mode.  This shows only your outlines of your objects, regardless of the 
stroke or fill you have applied to them. 
 
Adobe has renamed the Artwork mode to the 
Outline mode in Illustrator 9.0. Go to the View 
menu and select the Outline mode.  
 
Hotkeys can be used to control how shapes are created.  Holding the Shift key 
while drawing your shape will force it to maintain a 1:1 aspect ratio (width and 
height are equal). This helps you create perfect squares and circles. 
 
Holding the ALT key while drawing will create the object from the center rather 
than from the corner. This is helpful when placing a shape directly centered over 
another layer. 
 
The CTRL key can be held while dragging to move a shape you just created to a 
new location. 
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Selection of Objects 
 
The Selection tool is used to select an object and then move or resize the 
entire object.  Artists familiar with Illustrator will refer to this tool as the Solid 
Arrow tool. 

 
Draw a Rectangle as described on page 6 and then select the 
Solid Arrow tool.  Click your shape once using the Solid 
Arrow. You should notice an outline with adjustment points 
appear around your shape like the diagram on the left. By 
clicking and dragging the center of the shape or one of the lines 

of the border, you can move the object.  By clicking and dragging one of the 
square adjustment points, you can resize the object. 
 
The Direct Selection tool  also known as the Hollow Arrow tool is used to 
select specific points and then bend or move parts of a shape. Draw a new 
rectangle and then select only the upper right corner of the rectangle by using the 
Hollow Arrow.  The directions below will let us modify only a portion of our 
rectangle. 

1. Click and hold the mouse button at a point just above the middle of the 
top line of your rectangle. 

2. Drag to a point just beyond the middle of the right side of your rectangle. 
3. Release the mouse button. You should now have only the 

top right quadrant selected as shown in the picture at the 
right. You will notice that one of the adjustment points is 
darkened, signifying that it is the selection that is active. 

4. Use the cursor keys on the keyboard to move the 
selection around or use the Hollow Arrow tool to drag the 
adjustment point. You can see from the example at the 
right that we have changed the shape of our rectangle by 
collapsing the upper corner. 

 
The Hollow Arrow tool will become more familiar to you as we progress because 
it is vitally important for adjusting lines, shapes, and groups. 
 
Please note that by setting the preferences of your Illustrator program as described on page 4, 
you will make certain that your cursor keys move more precisely.  The larger the number in the 
Keyboard Increment box, the less precise your object movements with the cursor keys will be. 
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Precise Shapes and Duplication 
 
Illustrator’s tools can all be used to draw objects in a freehand method, but since 
this is vector-based drawing, you can add precision by using numbers. 
 
In this excersise we are going to create a set of four boxes, each 100x100 points, 
and each 20 points apart, laid out in four rows of four as shown below. 

 
A set of objects such as this can be created quickly and 
effortlessly by using the precise options of the Solid Arrow 
tool and the Rectangle tool. 
 
 
 
 

 
To begin, select the Rectangle tool and 
double-click somewhere towards the 
upper right of your artboard. A dialogue 
will appear asking for the measurements 
of your shape.  Enter the information as  
shown at the right and press OK 
 
A new square will have appeared where you had placed your arrow. 
 

Next, double-click on the solid arrow 
tool. You will now see a dialogue 
that allows you to move the 
currently selected object to a new 
location.  
 
Since we are interested in copying 
this square we have made 20 points 
to the right, we will place 120 in the 
Horizontal position. The reason we 
do this is that Illustrator includes the 
size of your object when moving. So 

if we have a 100 pt. Object and we want to start the next object 20 pts to the right 
of that object, we need to tell it to position the object 100 pts plus 20 pts.  To go 
the opposite direction, you simply place a – (minus) sign in front of the number. 
 
If you click COPY, your shape will be copied to the position you 
wanted.  If you push OK, your current object will be moved.  In 
our exercise, be sure to click Copy. You will then see something 
similar to the diagram to the right. 
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At this point, we will want to make two more squares across. Illustrator has a 
hotkey combination to allow you to duplicate your last action.  Rather than use 
the Solid Arrow to copy the shape, we can use this shortcut. 
 
Press CTRL + D.  You will see your new square appear, an equal distance from 
from the first. Press the combination again to create the fourth square.. You 
should now have four squares in a row, all equal size, all equal distance apart. 
 

Hold down the Shift key and click each of the four squares 
using the Solid Arrow. You should have them all selected 
like the diagram to the left. 

 
Now, double-click the Solid Arrow 
tool on the tool palette.  You will 
again see the Move dialogue box.  
This time, however, we want to copy 
our object below our current 
selection.  Therefore, we will need 
to use 100 pts + 20 pts and be sure 
to use a negative number. Make 
your data match those of the figure 
to the left. You should now see the 
diagram below. 

 
 
At this point, simply press CTRL + D twice to finish our 
shape group.  
 
 

Our finished product should look like this: 
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The Pen Tool 
 
The Pen tool is used to make paths. You create paths, and then connect them to 
create objects. The pen tool works by clicking on points, NOT by dragging the 
mouse as many try to do. 
 
To demonstrate this, click the Pen tool  and click once 
on your artboard.  Do not hold the mouse button down, just 
click.  Now, move your cursor directly across from that point 
and click again.  You can use the Shift key to restrain your mouse and force a 
straight line. You should now have something on your artboard that looks like the 

illustration to the right. 
 
Now, expand the Pen tool and choose the Add Point 
tool.  Click in the middle of the line you just created. You 
should now see a new point in the middle of the line. At 

this point, select the Convert Anchor tool  from the Pen 
pullout menu.  Click on your new middle point and drag to 
the right. Your line will now have what appears to be three 
points in the middle. The two outer middle points are your curve directions.  

 
Now, select the Hollow Arrow and drag the original 
midpoint up.  This will create a parabola as shown at the left. 
You can control the steepness and angle of the curve by 
dragging the two curve direction points in different directions. 
Experiment! 

 
Now, let’s draw that same object using only the pen tool and the Bezier Curve 
principle.  The pen tool can be used to specify the direction of your curve as you 
draw it, rather than adding the curve to an existing straight line as we have done. 
 
Select the Pen tool .  Click once on your artboard. Refer 
to this as Point 1 on the diagram to the right. Now, do the 
following. 
 

• Click and hold the mouse button at Point 2. 
• Drag the mouse slightly to the right and then release 
• Now click at Point 3. 

 
You can again use the Shift key to constrain your cursor so that your lines are 
straighter. You should have created an identical shape as before. 
 
Still another way to produce a curve is by clicking and holding at Point 1 and 
dragging straight up (signifying you want the curve to start going up). Next, click 
and hold at Point 3, but this time drag straight DOWN. You will see your curve 
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come back to where it started. You will have to drag down twice as far as you 
came up.. 
 
Let’s do a comprehensive drill called the Sunflower Drill. We are going to create 
a sunflower using the Circle tool and the Pen tool. 
 
Clear your artboard by pressing Ctrl + A and then pressing the Delete key. 

 
1. Draw a 100 x 100 pt circle. 
2. Press Ctrl + Shift + A to deselect the circle.   
3. Select the Pen tool. 
4. Click and drag up on the top of the circle. 
5. Click and drag down on the edge of the circle to the 

right of the point you started. Refer to the diagram at the 
left. 

6. Hold down the ALT key. The pen will change to the 
Convert Anchor to Curve tool. Place the cursor exactly 
over the point you just created in Step 5. You will see 

the cursor change to the pen again. At this point, click and drag away from 
the circle.  

7.  Now, click and drag towards the circle at a 
point farther down the circle. You should 
have the general idea after completing Step 
5. 

8. You should now have two petals on your 
flower. Repeat this process around the 
circle until you have connected your last petal 
to your first petal. 

9. At this point, you should have a completed flower. Now create another 100 
x 100 pt circle and place it directly over the original circle. (Their 
midpoints will help you place them in the same place). 

10. Switch to the Preview mode (It’s under the View menu) 
11. Select the petals with the Solid Arrow and then change the Fill to a 

yellow color. Turn off the stroke. 
12. Select the circle with the Solid Arrow and then change its Fill to brown. 

Turn off the stroke. 
 
Your finished flower should look like the example to the right.  
You can enter the Outline mode (View menu again) and then 
use the Hollow Arrow tool to adjust your petals. 
 
By now, the pen tool should be burned into your head. For 
another mind-bending exercise, try writing your name 
longhand using only the Pen tool. 
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Type Tool 
 
The Type tool works as you would expect. You simply select the tool, click on 
your drawing, and type what you want to appear.  That much needs no 
explanation. 
 
Many web graphic designers want to display text in cool ways. Plain straight text 
is boring.  Illustrator lets you make text curve, bend, distort, and even fill in 
shapes. 
 
Let’s first try making text on a path.  Draw that parabola you drew on Page 10 
using the Pen tool. 
 
Now, select the Path Type Tool  and click on your 
parabola. Now simply type your text and you will see it 
flow around your curve.   
 

You can invert the text on the path by selecting the new text path with 
the Hollow Arrow tool. You will see a grab-point appear at the front 
of the text as shown to your left. Click and drag this grab point to the 
opposite side and your text will follow you. Drag it to the opposite 

inside corner and your text will appear upside down. 
 
Text paths can be manipulated just like regular 
paths, by using the Hollow Arrow tool or the 
Pen tool.  Experiment. Remember that in 
Illustrator, any object has paths, so your text 
can flow around squares, stars, polygons, 
spirals, anything you can create. 

 
See if you can figure out how the Area Type Tool works.  
Make a circle and then fill it with text. 

 
 
 
You can also turn text into paths.  To do this, simply select 
the text with the Solid Arrow tool, and select Create 
Outlines from the Type menu.  This can be useful for 
exporting fonts to other projects or computers where your 
font might not be installed. The only drawback is that you 
can’t undo this once you’ve saved it, so you can’t edit the 
type anymore. 
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The Pathfinder 
 

Possibly the most useful feature in Illustrator, the 
Pathfinder makes some difficult tasks quite easy. 
In this introductory lesson, I am only going to 
cover three Pathfinder tools: Unite, Minus Front, 
and Minus Back. 
 
 

Unite  
 
 The Unite tool on the Pathfinder allows you to merge two 
objects together, creating a single object.  To see it in action, draw 
two squares. Make the second square overlap the bottom fourth of 
the first like the diagram to the right. 
 
Now, select both of these shapes using the Solid Arrow.  Click the 
Unite button  on the Pathfinder palette. This will create the shape 
to the right. The two shapes are gone and in their place is a single 
complete path. 
 
Minus Front  
 
 The Minus Front tool will remove the path that is on top of the 
path below it. Draw the same two squares, select them and press 
Minus Front on the Pathfinder palette. You will create a new object 
that looks like the one to the right. 
 
Minus Back  performs the same task, except that it removes the 
layer underneath, resulting in the figure to the right.  
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Compound Paths are paths that contain pieces that are cut out.  Imagine a 
doughnut or a tire. The inside is missing from the shape. These are very useful in 
Illustrator because they can be placed atop other layers and the “hole” in the path 
will allow the underlying objects to appear through. 
 
Lets create a compound path.  
 

1. Draw a square on the artboard  
2. Now make a circle inside of that square. .   
3. Select both objects with the Solid Arrow tool. 
4. Select the Compound Path menu from the 

Object menu and choose Make. 
 
 
You will now have a compound path. Drag this object over 
something else on your artboard, like your sunflower. You 
should see your sunflower through your object.  
 

 
 
 
 
 
 
 
 
 
 
Using Pathfinder and Compound Path, you can create block letters.  
Try writing your name in block letters using only the ellipse and rectangle tools in 
conjunction with compound paths and the Pathfinder. 
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Transformation Tools 
 
The Shear, Reflect, Rotate, and Scale tools are very powerful. They can help you 
achieve complex objects very quickly. 
 
Scale   
 
 The scale tool can be used to increase or decrease the size of the 
selected objects. You can scale from the center of the object, or you can scale 

from a specified point. Select your 
flower, and then double-click the 
Scale tool. 
 
Much like the Move tool, the Scale 
tool lets you put in numbers to do 
your scaling. There is a less-
precise freehand method you can 
experiment with as well. 
 
Simply enter a value in the box and 
click OK. Your flower will appear 
smaller (or larger if you entered 
something different from the figure 
to the left). 
 

Notice that there is a copy button as well. The copy button is great for using 
Scale to help make compound paths.  Try drawing a circle, then selecting it, then 
double-clicking the Scale tool and entering 70%.  This time, click Copy.  You 
should see two circles, perfectly aligned, one inside of the other. 
 
 
 
 
 
 
 
Experiment with the other tools. They all work pretty much the same way. 
 
That’s about it for the introductory lessons in Illustrator. I hope you learned some 
useful skills that you can apply to your graphics. Keep practicing and exploring.  
There is a lot to learn about Illustrator. 
 
 

 


